
Installing in VMware ESXi Environment

VMware ESXi, a hypervisor that allows the basic creation and management of virtual machines, is one of the
hypervisors supported by Cisco Catalyst 8000V. This hypervisor runs on an x86 hardware containing
virtualization extension, and you can use the same hypervisor to run several VMs simultaneously.

This chapter contains information about how to deploy Cisco Catalyst 8000V in ESXi, and the requirements
for a successful deployment. Before you read the requirements and the deployment procedures, see the
following information that tells you the various deplopyment methods for the ESXi hypervisor:

Deploying the OVA template on the VM

Deploying using the OVA file: In this method, you must download the .ova file from Software Download
page, and use this file for the deployment. Further, you can use the following two methods to deploy the OVA
file:

• Deploying using the vSphere client: In this procedure, you need a VMware vSphere Client or a vSphere
Web Client to deploy the *.ova installation file. The VMware vSphere Web Client is a web application
that runs on a x86 hardware containing virtualization extension and accesses the VMware vCenter Server.
You can use VMware vSphereWeb Client software to create, configure, andmanage VMs on the vCenter
Server and to start or stop a Cisco Catalyst 8000V instance.

This is the recommended method of deployment for Cisco Catalyst 8000V.Note

• Deploying using the Common Ovf Tool (COT): COT is a tool that allows you to edit virtual appliances
such as Cisco Catalyst 8000V. You can also use this tool to deploy the .ova file to the ESXi server and
provision the VM.

To learn more about VMware vSphere products, see VMware product documentation .

Manually deploying the .iso file

The third deployment option for the ESXi hypervisor is the manual creation of the VM and installation of
Cisco Catalyst 8000V by using the .iso file. Download the .iso file from the Cisco Software Download page
and use this file for the installation. In this method, you install the .iso file on the VMware ESXi host and
manually create the VM using the vSphere GUI. This option is advisable only if you want to modify the OVA.
However, note that this option is the least recommended since manual deployments invite opportunities to
stray from supported configurations.
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Create the VM using ESXi 6.5 or later. Ensure that you use VM version 13 or greater. To choose the EFI
firmware mode, navigate through VM Options > Boot Options > Firmware > EFI. The firmware mode is
required to enable the secure boot functionality. For more information, see the VNF Secure Boot chapter in
this guide.

Important

• VMware Requirements, on page 2
• Supported VMware Features and Operations, on page 3
• Deploying the OVA to the VM using vSphere, on page 6
• Deploying the OVA to the VM Using COT, on page 9
• Manually Creating the VM Using the .iso File, on page 14
• Increasing the Performance on VMware ESXi Configurations, on page 16

VMware Requirements
The following table specifies the supported VMware tools by Cisco Catalyst 8000V using Cisco IOS XE 17.4
and later releases:

vCenter ServervSphere Web ClientCisco IOS XE Release

VMware ESXi 6.7 and ESXi 6.5The 6.7 and 6.5 versions of the
VMware vSphere Web Client are
supported.

Cisco IOS XE 17.4.x releases

These versions have been fully tested and meet performance benchmarks.

VMware vCenter - installation tool.

VMware vSwitch - standard or distributed vSwitches are supported.

Hard Drive - only a single hard disk drive is supported. Multiple hard disk drives on a VM are not supported.

Virtual Disk - both 16GB and 8 GB virtual disks are supported.

vCPUs - the following vCPU configurations are supported:

• 1 vCPU: requires minimum 4 GB RAM allocation

• 2 vCPUs: requires minimum 4 GB RAM allocation

• 4 vCPUs: requires minimum 4 GB RAM allocation

• 8 vCPUs: requires minimum 4 GB RAM allocation

The required vCPU configuration depends on the throughput license and technology package installed. For
more information, see the data sheet for your release.

Note

ESXi hypervisor - The minimum requirement is ESXi 6.5 Update 2 or ESXi 6.7 Update 3.

Virtual CPU core - one virtual CPU core is required. This needs a 64-bit processor with Virtualization
Technology (VT) enabled in the BIOS setup of the host machine.
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Virtual hard disk space - minimum size of 8 GB.

Virtual Network Interface Cards (vNICs) - A maximum of 8 vNICs is supported; VMXNET3, iXGBeVF,
and i40eVF.

A default video, SCSI controller set is required, and an installed virtual CD/DVD drive.

Familiarize yourself about the secure boot configuration before you proceed with the installation. To see
information about secure boot, see the VNF Secure Boot chapter in this guide.

Do not use a standalone vSphere client to manage the ESXi server. Starting ESXi 6.0, it is no longer possible
to directly deploy Cisco Catalyst 8000V in ESXi in the case of an ova deployment. You must have a vMware
vCenter server and a vSphere client to deploy a .ova file.

Note

Supported VMware Features and Operations
VMware supports various features and operations that allow you to manage your virtual applications and
perform operations such as cloning, migration, shutdown and resume.

Some of these operations cause the runtime state of the VM to be saved and then restored upon restarting. If
the runtime state includes traffic-related state, then on resumption or replaying the runtime state, additional
errors, statistics, or messages are displayed on the user console. If the saved state is just configuration driven,
you can use these features and operations without a problem.

The Supported VMware Features and Operations: Storage Options (for Both vCenter Server and vSphere
Client) table lists the VMware features and operations that are supported on Cisco Catalyst 8000V. For more
information about VMware features and operations, see the VMware Documentation .

The following VMware features and operations are not supported in all versions of Cisco Catalyst 8000V,
but can still be used or performed on non-supported versions at the risk of encountering dropped packets,
dropped connections, and other error statistics:

• Distributed Resource Scheduling (DRS)

• Fault Tolerance

• Resume

• Snapshot

• Suspend

General Features (vCenter Server)
Table 1: Supported VMware Features and Operations: General Features (for vCenter Server Only)

DescriptionSupported Entities

Enables cloning a virtual machine or template, or cloning a virtual machine to a template.Cloning
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DescriptionSupported Entities

The entire state of the virtual machine as well as its configuration file, if necessary, is moved to the new host
even while the data storage remains in the same location on shared storage.

Migrating

Enables moving the VM from one physical server to another while the VM remains active.vMotion

Uses templates to create new virtual machines by cloning the template as a virtual machine.Template

Operations (for vCenter Server and vSphere Web Client)
Table 2: Supported VMware Features and Operations: Operations (for vCenter Server and vSphere Client)

DescriptionSupported Entities

Powers on the virtual machine and boots the guest operating system if the guest operating system is installed.Power On

Stops the virtual machine until it is powered back. The power off option performs a “hard” power off, which is
analogous to pulling the power cable on a physical machine and always works.

Power Off

Shut Down, or “soft” power off, leverages VMware Tools to perform a graceful shutdown of a guest operating
system. In certain situations, such as when VMware Tools is not installed or the guest operating system is hung,
shut down might not succeed and using the Power off option is necessary.

Shut Down

Suspends the virtual machine.Suspend

Stops the virtual machine and restarts (reboots) it.Reset/Restart

An OVF package consisting of several files in a directory captures the state of a virtual machine including disk
files that are stored in a compressed format. You can export an OVF package to your local computer.

OVF Creation

You can create a single OVA package file from the OVF package/template. The OVA can then be distributed
more easily; for example, it may be downloaded from a website or moved via a USB key.

OVA Creation

Table 3: Supported VMware Features and Operations: Networking Features

DescriptionSupported Entities

From both vCenter Server and vSphere Client. Allows you to set up the MAC address manually for
a virtual network adapter.

Custom MAC address

From vCenter Server only. A vSphere distributed switch on a vCenter Server data center can handle
networking traffic for all associated hosts on the data center.

Distributed VSwitch

Provides automatic load balancing across hosts.Distributed Resources
Scheduler

From both vCenter Server and vSphere Client. Load balancing and failover policies allow you to
determine how network traffic is distributed between adapters and how to reroute traffic if an adapter
fails.

NIC Load Balancing
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DescriptionSupported Entities

From both vCenter Server and vSphere Client. Allows you to set up an environment where each
virtual switch connects to two uplink adapters that form a NIC team. The NIC teams can then either
share the load of traffic between physical and virtual networks among some or all of its members,
or provide passive failover in the event of a hardware failure or a network outage.

NIC Teaming can cause a large number of ARP packets to flood the Cisco Catalyst 8000V
and overload the CPU. To avoid this situation, reduce the number of ARP packets and
implement NIC Teaming as Active-Standby rather than Active-Active.

Note

NIC Teaming

From both vCenter Server and vSphere Client. A vSwitch is a virtualized version of a Layer 2 physical
switch. A vSwitch can route traffic internally between virtual machines and link to external networks.
You can use vSwitches to combine the bandwidth of multiple network adapters and balance
communications traffic among them. You can also configure a vSwitch to handle a physical NIC
fail-over.

vSwitch

High Availability

Cisco IOS-based High Availability is not supported by the Cisco Catalyst 8000V instance. High Availability
is supported on the VM host only.

Note

Table 4: Supported VMware Features and Operations: High Availability

DescriptionSupported Entities

Tomonitor operating system failures, VM-Level HighAvailability
monitors heartbeat information in the VMware High Availability
cluster. Failures are detected when no heartbeat is received from
a given virtual machine within a user-specified time interval.
VM-Level High Availability is enabled by creating a resource
pool of VMs using VMware vCenter Server.

VM-Level High Availability

To monitor physical servers, an agent on each server maintains a
heartbeat with the other servers in the resource pool such that a
loss of heartbeat automatically initiates the restart of all affected
virtual machines on other servers in the resource pool. Host-Level
High Availability is enabled by creating a resource pool of servers
or hosts, and enabling high availability in vSphere.

Host-Level High Availability

Using high availability, fault tolerance is enabled on the ESXi
host. When you enable fault tolerance on the VM running the
Cisco Catalyst 8000V instance, a secondary VM on another host
in the cluster is created. If the primary host goes down, then the
VM on the secondary host will take over as the primary VM for
the Cisco Catalyst 8000V.

Fault Tolerance
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Storage Options (for vCenter Server and vSphere Web Client)
Table 5: Supported VMware Features and Operations: Storage Options (for Both vCenter Server and vSphere Client)

DescriptionSupported Entities

Storage Options (for both vCenter Server and vSphere Client)

Local storage is in the internal hard disks located inside your ESXi
host. Local storage devices do not support sharing across multiple
hosts. A datastore on a local storage device can be accessed by
only one host.

Local Storage

You can deploy the Cisco Catalyst 8000V instance on external
storage. That is, a Storage Area Network (SAN).

External Storage Target

You can connect USB sticks to the Cisco Catalyst 8000V instance
and use them as storage devices. In ESXi, you need to add a USB
controller and then assign the disk devices to the Cisco Catalyst
8000V instance.

• Cisco Catalyst 8000V supports USB disk hot-plug.

• You can use only two USB disk hot-plug devices at a time.

• USB hub is not supported.

Mount or Pass Through of USB Storage

Deploying the OVA to the VM using vSphere
The Cisco Catalyst 8000V OVA file package allows you to deploy the Cisco Catalyst 8000V to the VM. The
OVA package includes an OVF file that contains a default VM configuration based on the Cisco IOS XE
release and the supported hypervisor.

Restrictions and Requirements
The following restrictions apply when deploying the OVA package to the VM:

If the virtual CPU configuration is changed, you must reboot the Cisco Catalyst 8000V instance. Changing
the RAM allocation does not require you to reboot the Cisco Catalyst 8000V instance.

The OVA package provides an option to select the virtual CPU configuration.

When you deploy the OVA, the VM requires two virtual CD/DVD drives, one for the OVF environment file
and one for the .iso file.

Deploying the OVA to the VM
Perform the following steps in VMware vSphere Client:
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Step 1 Log in to the VMware vSphere Client.
Step 2 From the vSphere Client Menu Bar, choose File > Deploy OVF Template.
Step 3 In the OVA Wizard, point the source to the Cisco Catalyst 8000V OVA to be deployed. Click Next.

The system displays the OVF Template Details with the information about the OVA. Click Next.

Step 4 Under Name and Inventory Location, specify the name for the VM and click Next.
Step 5 Under Deployment Configuration, select the desired hardware configuration profile from the drop-down menu and

click Next.
Step 6 Under Storage, select the Datastore to use for the VM. Click Next.
Step 7 Under Disk Format, select the disk format option:

• Thick Provision Lazy Zeroed

• Thick Provision Eager Zeroed

The Thin Provision option is not supported. The Thick Provision Eager Zeroed option takes longer to install
but provides better performance.

Note

Click Next.

Step 8 UnderNetwork Mapping, allocate one or more virtual network interface card (vNIC) on the destination network using
the drop-down list.

Select the network mappings for the 3 default vNICs created during the OVA deployment. You can choose which vNIC
will map to the router’s management interface when setting the bootstrap properties.

After you make any change to the bootstrap properties, the system assumes that you are starting with a fresh
VM. So, when the VM restarts, all the pre-existing networking configuration is removed.

Note

Step 9 Select the vNIC to connect at Power On. Click Next.

When the Cisco Catalyst 8000V installation using the OVA is complete, two additional vNICS are allocated. Cisco
Catalyst 8000V supports up to ten vNICs. You must manually create additional vNICs on the VM.

Step 10 Configure the properties for the VM.

After you make any change to the bootstrap properties the system assumes that you are starting with a fresh
VM. So when the VM restarts, all pre-existing networking configuration is removed.

Note

The bootstrap properties are optional when creating the VM. You can set these properties to easily provision
the VM before starting it up.

Note

Table 6: OVA Bootstrap Properties

DescriptionProperty

Bootstrap Properties

Configures the console mode.

Possible values: virtual, serial

Console

Sets the login username for the router.Login Username
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DescriptionProperty

Sets the login password for the router.Login Password

Designates the management interface for the Cisco Catalyst 8000V instance. The format
must be GigabitEthernetx or GigabitEthernetx.xxx.

The GigabitEthernet0 interface is no longer supported.Note

Management Interface

Configures the dot1Q VLAN interface. Requires the management interface to be
configured using the GigabitEthernetx.xxx format.

Management vLAN

Configures the IPv4 address and subnet mask for the management interface.Management Interface IPv4 Address/Mask

Configures the IPv4management default gateway address. If using DHCP, enter “dhcp”
in the field.

Management IPv4 Default Gateway

Configures the IPv4management default gateway address. If using DHCP, enter “dhcp”
in the field.

Management IPv4 Gateway

Configures the IPv4Network (such as “192.168.2.0/24” or “192.168.2.0 255.255.255.0”)
that the management gateway should route to. If a default route (0.0.0.0/0) is desired,
this may be left blank.

Management IPv4 Network

Configures the IP address of the Cisco Prime Network Services Controller.

This setting is used if you plan to remotely manage the Cisco Catalyst 8000V instance
using the Cisco Prime Network Services Controller.

PNSC IPv4 Address

Configures the hostname of the router.Router name

Configures the Resource Template.

Possible values: default, service_plane_medium, service_plane_heavy

Resource Template

Features

Enables the IOS SCP feature.Enable SCP Server

Enables remote login using SSH and disables remote login via Telnet. Requires that
the login username and password are set.

Enable SSHLogin andDisable Telnet Login

Additional Configuration Properties

Configures the password for privileged (enable) access.Enable Password

Configures the network domain name.Domain Name

Configures the license technology level that is available when the Cisco Catalyst 8000V
instance boots.

License Boot Level

After you configure the router properties, click Next. The system displays the Ready to Complete screen with the
settings to be used when the OVA is deployed.

You can also configure advanced properties after the router boots.
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Step 11 Select Power On After Depolyment to automatically power on the VM.
Step 12 Click Finish to deploy the OVA.

The OVA deploys the .iso file, and if you select the Power on after deployment setting, the VM is automatically
powered on. Once the VM is powered on, the Cisco Catalyst 8000V device begins the installation and boot process. If
a bootstrap configuration file was included in the OVA, the router configuration is automatically enabled.

For more information, see Booting the Cisco Catalyst 8000V and Accessing the Console.

Deploying the OVA to the VM Using COT
The Cisco Catalyst 8000V OVA file package allows you to deploy the Cisco Catalyst 8000V to the VM. The
OVA package includes an OVF file that contains a default VM configuration based on the Cisco IOS XE
release and the supported hypervisor. You can deploy the OVA using VMware vSphere or COT or the Common
OVF Tool. This section describes how to deploy using the COT.

The Common OVF Tool (COT) included in the Cisco Catalyst 8000V software package is a Linux-based
application that enables you to create attributes for one or more VMs and quickly deploy VMs with the Cisco
Catalyst 8000V software pre-installed. This tool can speed the process of deploying Cisco Catalyst 8000V
on multiple VMs.

COT provides a simple command-line interface to enter the VM attributes into the .ova file. You can run COT
either in a LINUX shell or on Mac OS X. However, ensure that VMware ovftools are installed.

The Common OVF Tool (COT) is provided without official Cisco support. Use it at your own risk.Danger

Downloading COT
Download and install the COT libraries and script according to the instructions provided in the
http://cot.readthedocs.io/en/latest/installation.html GitHub site.

Editing the Basic Properties of Cisco Catalyst 8000V using COT
Before you deploy Cisco Catalyst 8000V using COT, you can edit the basic or custom properties of the Cisco
Catalyst 8000V VM in the OVA package using COT.

To edit the basic properties of the OVA, use the cot edit-properties command.

cot edit-properties

-p key1=value1, --properties key1=value1

This command sets properties using key value pairs. For Example, -p "login-username=cisco" sets the login
username using a key value pair.

-o output

Specifies the name or the path to a new OVA package, if you are creating a new OVA instead of updating
the existing OVA.
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For more information on the cot edit-properties command, see:
http://cot.readthedocs.io/en/latest/usage_edit_properties.html

Editing the Basic Properties of Cisco Catalyst 8000V using COT [Sample]

cot edit-properties c8000v-universalk9.ova
-p "login-username=cisco"

-p "login-password=cisco"
-o c8000v-universalk9-customized.ova
\# save modifications to a new OVA
cot info c8000v-universalk9-customized.ova
# verify the new values of properties in the OVA

(...)
Properties:
<config-version> "1.0"
Router Name ""
Login Username "cisco"
Login Password "cisco"
Management Interface "GigabitEthernet1"
Management VLAN ""
Management Interface IPv4 Address/Mask ""

The following table specifies the cot edit-properties command and arguments used in the above example.

DescriptionScript Step

Edits the basic environment properties of the OVA file.
cot edit propertie
s c8000v-universalk9.ova

Sets the bootstrap login username.
-p "login-username=cisco"

Sets the bootstrap login password.
-p "login-password=cisco"

Saves a modified OVA, which contains configuration
commands from the text file.-o "c8000v-universalk9-customized.ova"

Editing the Custom Properties
You can add custom properties to your Cisco Catalyst 8000V instance based on the Cisco IOS XE CLI
commands using the vSphere GUI. You can add these properties either before or after you boot the Cisco
Catalyst 8000V instance. If you set these custom properties after you boot the Cisco Catalyst 8000V instance,
you must reload the router or power-cycle the VM for the properties settings to take effect.

To edit the vApp options to add the custom Cisco Catalyst 8000V properties, do the following:

Step 1 In the vSphere GUI, select the Options tab.
Step 2 Select vApp Options > Advanced.
Step 3 In the Advanced Property Configuration screen, click the Properties button.
Step 4 Click New to add a property.
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Step 5 In the Edit Property Settings screen, enter the information to create the new custom property based on a Cisco IOS XE
CLI command:

Before adding a custom property, make sure that the Cisco IOSXE command upon which it is based is supported
for your Cisco Catalyst 8000V version.

Note

a) (Optional) Enter the label. This is a descriptive string for the property.
b) Enter the class ID as “com.cisco.c8000v”.
c) Assign the property an ID of “ios-config-xxxx” where xxxx is a sequence number from 0001 to 9999 that determines

the order in which the custom properties are applied.
d) (Optional) Enter a description for the property.
e) Enter the property type as “string”. This is the only type supported.
f) Enter the default value as the Cisco IOS XE CLI command the custom property is based on.

Step 6 Click OK.
Step 7 In the Advanced Property Configuration screen, click OK.
Step 8 Reboot the Cisco Catalyst 8000V instance.

You must reboot the router for the new or edited properties to take effect.

cot edit-properties
Use the cot edit-properties command to pre-apply a small number of configuration commands to the OVA.

To use more commands, use the cot inject-config command.

For more information about the cot edit-properties command, see
http://cot.readthedocs.io/en/latest/usage_edit_properties.html .

Synopsis and Description

cot edit-properties ova-filename

-o output

Specifies the name or path to a new OVA package, if you are creating a new OVA instead of updating the
existing OVA.

-c config-file

Specifies the name of a text file containing IOS XE commands to be added to the OVA.

Example

In this example, a previously created text file, iosxe_config.txt, containing IOSXE config commands is added
to the OVA using the cot edit-properties command. Finally, the cot info command is used to show the
modified OVA.

$ cat iosxe_config.txt

interface GigabitEthernet1
no shutdown
ip address 192.168.100.10 255.255.255.0
!

Installing in VMware ESXi Environment
11

Installing in VMware ESXi Environment
cot edit-properties

http://cot.readthedocs.io/en/latest/usage_edit_properties.html


ip route 0.0.0.0 0.0.0.0 GigabitEthernet1 192.168.100.1
$ cot edit-properties c8000v-universalk9.ova \

-o c8000v-universalk9-customized.ova \
-c iosxe_config.txt

$ cot info c8000v-universalk9-customized.ova

...

Properties:
<config-version> "1.0"
Router Name ""

...

Intercloud Tunnel Interface Gateway IPv4 Address ""
<ios-config-0001> "interface GigabitEthernet1"
<ios-config-0002> "no shutdown"
<ios-config-0003> "ip address 192.168.100.10 255.255.255.0"
<ios-config-0004> "ip route 0.0.0.0 0.0.0.0 GigabitEthernet1 192.168.100.1"

The following table specifies the cot edit properties command and arguments used in the example.

DescriptionScript Step

Edits the custom environment properties of the OVA file.
cot edit properties
c8000v-universalk9.ova

NewOVA, containing configuration commands from the text file.
-o
"c8000v-universalk9-customized.ova"

The text file that contains IOSXE configuration commands. Each
line of configuration in this file results in an entry such as
com.cisco.productname.ios-config-xxxx in the XML of the OVF.

-c iosxe_config.txt

cot inject-config
Use the cot inject-config command if you have a large set of configuration commands to pre-apply to the
OVA. For example, if you want to add a complete running configuration. This is efficient in terms of file size
and loading time as this command uses plain text for the configuration commands (instead of XML). For
further details about the cot inject-config command, see
http://cot.readthedocs.io/en/latest/usage_inject_config.html

Synopsis and Description

cot inject-config ova-filename

-o output

Specifies the name or path to a new OVA package if you are creating a new OVA instead of updating the
existing OVA.

-c config-file

Specifies the name of a text file, such as iosxe_config.txt to be embedded in the OVA.
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Example

In this example, the cot inject-config command adds Cisco IOS XE commands in text file iosxe_config.txt
to the OVA.

$ cat iosxe_config.txt
interface GigabitEthernet1
no shutdown
ip address 192.168.100.10 255.255.255.0
!
ip route 0.0.0.0 0.0.0.0 GigabitEthernet1 192.168.100.1
$ cot inject-config c8000v-universalk9.ova \

-o c8000v-universalk9-customized.ova \
-c iosxe_config.txt

$ cot info c8000v-universalk9-customized.ova

<.. other output snipped for brevity ..>

Files and Disks: File Size Capacity Device
--------- --------- --------------------

c8000v_harddisk.vmdk 71.50 kB 8.00 GB harddisk @ SCSI 0:0
bdeo.sh 52.42 kB
README-OVF.txt 8.53 kB
README-BDEO.txt 6.75 kB
cot.tgz 116.78 kB
c8000v-universalk9.iso 484.80 MB cdrom @ IDE 1:0
config.iso 350.00 kB cdrom @ IDE 1:1

The following table specifies the cot inject-config command and arguments used in the example.

DescriptionScript Step

Edits the custom environment properties of the OVA file.
cot inject-config
c8000v-universalk9.ova

The name of the new or the modified OVA, containing the config
commands from the text file.-o

"c8000v-universalk9-customized.ova"

The name of the text file that contains the IOS XE configuration
commands.-c iosxe_config.txt

Deploying the Cisco Catalyst 8000V VM using COT
To deploy the Cisco Catalyst 8000V VM, use the cot deploy ... esxi command as shown in the following step.
Note that the following description provides general guidance. The exact steps that you need to perform may
vary depending on the characteristics of your VMware environment and setup.

Run the cot deploy ... esxi command to deploy the Cisco Catalyst 8000V. The script options are described at:
http://cot.readthedocs.io/en/latest/usage_deploy_esxi.html

The default values may vary depending on the Cisco Catalyst 8000V version.Note
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Example
The table below shows an example cot deploy command, and its arguments, that is used to deploy a Cisco
Catalyst 8000V VM in a vCenter environment.

DescriptionScript Step

cot deploy

vCenter server 10.122.197.5, target host
UCS/host/10.122.197.38-s '10.122.197.5/UCS/host/10.122.197.38'

Credentials for the ESXi server. If unspecified, COT
will use your userid and prompt for a password.-u administrator -p password

Name of the newly created Cisco Catalyst 8000VVM.
-n XE3.13

OVF hardware config profile. If this is not specified,
COT displays a list of available profiles and prompts
you to select one.

-c 1CPU-4GB

Mapping each NIC in the Cisco Catalyst 8000VOVA
to a vSwitch on the server.-N "GigabitEthernet1=VM Network"

-N "GigabitEthernet2=VM Network"
-N "GigabitEthernet3=VM Network"

Target hypervisor (currently always ESXi)
esxi

OVA to deploy
~/Downloads/c8000v-universalk9.ova

Any ESXi-specific parameters - here, the datastore to
use for disk storage.-ds=datastore38a

Manually Creating the VM Using the .iso File
Perform the following steps to install the .iso file on the VMware ESXi host and manually and create the VM
using the vSphere GUI. While this procedure provides general guidance for how to deploy Cisco Catalyst
8000V, the exact steps that you need to perform may vary depending on the characteristics of your VMware
environment and setup. The instructions in this procedure are based on VMware ESXi 5.0.

Step 1 Download the C8000V_esxi.iso file from the Cisco Catalyst 8000V software installation image package and copy it
onto the VM Datastore.

Step 2 In the VSphere client, select Create a New Virtual Machine option.
Step 3 Under Configuration, select the option to create a Custom configuration, and click Next.
Step 4 Under Name and Location, specify the name for the VM and click Next.
Step 5 Under Storage, select the datastore to use for the VM. Click Next.
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Step 6 From the Virtual Machine Version field, select Virtual Machine Version 15 or a higher version that is availble.
Click Next.

Cisco Catalyst 8000V is not compatible with ESXi Server versions prior to 6.5 Update 2.Note

Step 7 Under Guest Operating System, select Linux and the Other 3.x Linux (64-bit) setting from the drop-down menu.
Click Next.

Step 8 Under CPUs, select the following settings:

• Number of virtual sockets (virtual CPUs)

• Number of cores per socket

The number of cores per socket should always be set to 1, regardless of the number of virtual sockets selected. For
example, a Cisco Catalyst 8000V with a 4 vCPU configuration should be configured as 4 sockets and 1 core per socket.

Click Next.

Step 9 Under Memory, configure the supported memory size for your Cisco Catalyst 8000V release. Click Next.
Step 10 Under Network, allocate at least three virtual network interface cards (vNICs).

a) Select the number of vNICs that you want to connect from the drop-down menu.

The VMware ESXi 5.0 interface only allows the creation of 4 vNICS during the initial VM creation. You
can add more vNICs after the VM is created and you boot the Cisco Catalyst 8000V the first time.

Note

b) Add the vNICs.

Select a different network for each vNIC.

Select the adapter type from the drop-down menu. See the requirements sections in this guide for the supported
adapter type in your release.

c) Select all the vNICs to connect at power-on.
d) Click Next.

You can add vNICs into the VM using vSphere while the Cisco Catalyst 8000V is running. For more
information about adding vNICS to an existing VM, see the vSphere documentation.

Note

Step 11 Under SCSI Controller, select VMware Paravirtual. Click Next.
Step 12 Under Select a Disk, click Create a New Virtual Disk.
Step 13 From the Create a Disk field, configure the following:

a) Capacity: Disk Size: See the requirements sections in this guide for the virtual hard disk size required in your
release.

b) Disk Provisioning: select one of the following: Thick Provision Lazy Zeroed or Thick Provision Eager Zeroed.

The Thin Provision option is not supported. The Thick Provision Eager Zeroed option takes longer to
install but provides better performance.

Note

c) Location: Store with the Virtual Machine

Click Next.

Step 14 From the Advanced Options field, select SCSI (0:0) for the virtual device node.
Step 15 On the Ready to Complete screen, click the Edit the Virtual Machine settings before completion. Select the Continue

checkbox.
Step 16 In the Hardware tab, click New CD/DVD Drive.
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a) Select the Device Type that the VM will boot from:

Select theDatastore ISO file option to boot from the .iso file. Browse to the location of the .iso file on the datastore
set in step 1.

b) In the Device Status field, select the Connect at Power On checkbox.
c) Select the Virtual Device Node CD/DVD drive on the host that the VM will boot from.

Step 17 In the Resources tab, click the CPU setting:

Set the Resource Allocation setting to Unlimited.

Step 18 Click OK.
Step 19 Click Finish.

The VM is now configured for the Cisco Catalyst 8000V and is ready to boot. The Cisco Catalyst 8000V is booted
when the VM is powered on. See the Booting the Cisco Catalyst 8000V and Accessing the Console section.

To configure the day0 settings of a manually installed Cisco Catalyst 8000V, attach a second CD/DVD drive
pointing to an ISO that contains the said bootstrap configuration. For further details on the supported bootstrap
ISO contents, see the Configuring Day0 Settings chapter in this guide.

Note

To access and configure the Cisco Catalyst 8000V from the serial port on the ESXi host instead of the virtual
VGA console, provision the VM to use this setting before powering on the VM and booting the router.

Note

Increasing the Performance on VMware ESXi Configurations
You can improve the performance of Cisco Catalyst 8000V running on ESXi environment by modifying the
settings on the host and the virtual machine.

• Enable the hypervisor performance settings.

• Limit the overhead of vSwitch by enabling SR-IOV on the supported Physical NICs.

• Configure the vCPUs of the VM to run on the same NUMA node as Physical NICs.

• Set the VM Latency Sensitivity to High.

For more information about the VMware best practices for versions 6.7 and 6.5, see https://www.vmware.com/
content/dam/digitalmarketing/vmware/en/pdf/techpaper/performance/Perf_Best_Practices_vSphere65.pdf
and https://www.vmware.com/techpapers/2019/
vsphere-esxi-vcenter-server-67U2-performance-best-practices.html.

Modifications to the Host Configuration

To improve the performance of the VMware ESXi configuration, perform the following modifications in the
host configuration:

• Select the High Performance option under Power Management.

• Disable Hyperthreading.

• Enable SR-IOV for the supported physical adapters.
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Modifications to the Virtual Machine Configuration

To improve the performance of the VMware ESXi configuration, perform the following modifications in the
host configuration:

• Ensure that the ESXi version is compatible with your Cisco Catalyst 8000V version.

• Set the Virtual Hardware: CPU reservation setting to Maximum.

• Reserve all the guest memory in Virtual Hardware: Memory.

• Select VMware Paravirtual from Virtual Hardware: SCSI Controller.

• From theVirtual Hardware: Network Adapter: Adapter Type option, select SR-IOV for the supported
NICs

• Set the General Guest OS Version > VM Options option to Other 3.x or later Linux (64-bit).

• Set the VM Options option under Advanced Latency Sensitivity to High.

• Under VM Options > Advanced Edit Configuration, add “numa.nodeAffinity” to the same NUMA
node as the SRIOV NIC.
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